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Using the 2006 Club State Tax Printer

This Tax Printer program works by reading your Club Accounting data, performing
certain calculations, then generating your tax forms. The program does not alter
your origina club data stored in the Club Accounting software. To properly usethis
program, you must make sure your accounting records are up-to-date. We recom-
mend running the year-end wizard and the 2006 Club Federal Tax Printer before
preparing your state taxes.

The 2006 Club State Tax Printer isavailable only for the following sates:
° Arizona

Cdlifornia

Georgia

Maryland

Massachusetts

Minnesota

Missouri

New Y ork

Colorado — New for 2006!

New Jersey — New for 2006!

Pennsylvania— New for 2006!

System Requirements

Use of this software requires at least:
A compatible Windows operating system (Windows 2000/Windows XP)
128 MB of RAM minimum (256 MB recommended).
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30 MB of free hard drive space.
Adobe Acrobat 6.0 (required to process PDF files). Adobe Acrobat can be
downloaded free of charge from http://www.adobe.com.

Club Accounting version 3.1 (CA3.1) or higher.

Installing the Club State Tax Printer

To ingtall the program there are two install ation options, CD or Download:

If you have received a CD:
Insert the CD into your computer’s CD-ROM drive. Theinstallation pro-
gram should launch automatically.

If you ar e downloading the program from the Inter net:
The ingallation program should launch automatically if you select Open.
If you choose not to allow automatic ingallation, or choose to Save, you
can ingall the program manually by clicking on the 2006 Club State Tax
Printer Setup icon.

Preparing the Club Data
ip this step if you have already run the 2006 Club Federal Tax Printer.

Before generating your tax forms, you should make sure that your club accounting
datais properly prepared.

We recommend that you wait until you have all the necessary data and have per-
formed a reconciliation of all the partnership accounts before completing your taxes.
Necessary data includes your year-end brokerage firm and bank statements, includ-
ing details of all buy, sdll, dividend, interest, service charge and other transactions
for the entire year through December 31, 2006. It is likely that you will not have this
information until mid- to late January.

Once you have al the necessary data and the club has conducted their annual audit,
close out the books for the year:
1) Launch Club Accounting.
2) Select Tools > Year-end Tasksfrom the menu. Follow the instructionsto
close your books for the year.
3) Exit the program.

Running the Club State Tax Printer
all The Presidential Demo Club — Club Accounting

File Edit View Club Transactions Reports Taxes Tools Help

;) Club

“N Prepare for Meeting
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The Club State Tax Printer does not operate as a separate program on your com-
puter. Instead, it isinstalled as part of your Club Accounting 3 software. To use the
Club State Tax Printer, smply select Taxes from the Club Accounting 3 menu to
prepare your tax filings.

If you have multiple clubs set up in your Club Accounting software, each time the
Tax Printer islaunched, you will need to select which club you wish to work with
from alist of club names. If you would like to use the Tax Printer program to gener-
ate tax forms for several clubs, you will need to purchase a Tax Printer serial num-
ber for each club. See http://www.iclub.com for moreinformation on how to pur-
chase additional serial numbers.

Registration e —
) ) ) ) Sefal®: [Crw [ures - [ [aor

When starting the tax printer for thefirst time, b [Fhe GE 2706 Do Gub
you will see theregistration window. You S [
must register your program over the Internet S [——
with your Tax Printer serial number before it ; :
. Counhy: |u:u|.v1 Ll cf Anperica d
IS u%bl e Al e |I.-.' T B Sbewl
Your Tax Printer serial number (beginning [ Famr
with CXW) is proof that you purchased ali- ity [t
cense to use this program. It isincluded with saie: s @ (216
your Tax Printer packaging. Prene: T oEn  Fet |
If you purchased the downloadable version of =
this program, your Tax Printer serial number AT AR RS =S
will be provided to you via email. Eanel

Entering Your Club Information

Once you haveregistered, you will see a screen listing the states which areincluded
in the 2006 Club State Tax Printer. Choose your state and click OK.

On the following screens, you will be prompted to enter information about your
club needed to generate your club’s tax forms.

The specific questions and input required vary by state. Please refer to the help files
within the program for information that is relevant to your specific state's tax return.

Generating Your Tax Forms
You arenow ready to print your State Tax Return.

Y ou should generate a complete return, and then, if your state requires a schedule
similar to the IRS Schedule K-1, extra copies of this schedule for each member.

Check the appropriate boxes to print the:
Main tax return
Additiona schedules (if appropriate to your state)
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Creating PDF files:
Selecting Finish will launch Adobe Acrobat and generate the formsin PDF format.
From Adobe Acrobat, you can save or print your tax forms.

Printing your tax forms:
To print tax forms, click on the printer icon or go to the File > Print menu item
after you'’ ve created a PDF file copy of your club’s tax return.

Saving your tax forms:

To save your tax formsin PDF format, click on the disk icon or go to the File >
Save menu item. The files will be saved in Adobe’' s PDF format. Y ou may read
these at anytime using the Adobe Acrobat Reader.

Additional notes:

A “Partner’ sidentifying number” for each member may be required for the club’s
tax return to be complete. If the message No Tax ID Entered shows up next to a
member’ s name on the final step, or that box is empty, that member’s Social Secu-
rity Number was not entered in Club Accounting. Fill it out by hand after you have
printed the appropriate tax form.

Sdect Quit to exit the Tax Printer.

What You Must Send to Your State Tax Department

2006 Club State Tax Printer software prints returns and schedulesrequired for filing
your club’stax return in aformat acceptable to your state's Tax Department.

Ingructions for what to send and where to send your return can be found on the
cover sheet printed with the return.

What You Must Give to Your Members

If your state requiresit, give each club member a copy of higher state equivalent to
the federal Schedule K-1. This schedule will be used in filing their persona state tax
returns. Thisincudes members who withdrew from the club during the year.

What You Must Keep for Club Records

The club should keep a copy of the full statetax return, all attached schedules and
any additional supporting statements and attachments as part of its permanent re-
cords.

Common Problems and Release Notes

2006 Club State Tax Printer requires registration before the program can be
run. Registration can be done over the Internet from within the registration
screen.
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If you find the program taking along timeto load your Adobe Acrobat Reader
and Tax Forms, your computer may lack sufficient memory or free hard drive
space. Select fewer forms to print faster, then repeat this process for the remain-
ing forms.

Linksto al pertinent state forms and instructions can be found within the help
section of the program.

The 2006 Club State Tax Printer software uses industry standard Adobe Acro-
bat software to generate your tax forms. A free copy of Adobe Acrobat Reader
installswith the tax program, and can a so be downloaded from
http://www.adobe.com.

Help from ICLUBcentral

Technical Support isavailable on our web site at http://www.iclub.com/support.

Y ou may ask specific questions via our web form and review the Frequently Asked
Questions section of the web site aswell.

If you cannot solve your problem using online help, the most efficient way to con-
tact an ICLUBcentral Technical Support Representative is to use our web help
forms|ocated at http://www.iclub.com/support/. Our expertswill then easily be able
to retrieve and reply to your question or problem quickly and efficiently.

Answers to questions about installation of the Club State Tax Printer areincluded
with your purchase of the software. Questions about club accounting principles, tax
issues, and the Club Accounting software are covered by your Club Accounting
Maintenance Agreement. To receive full coverage, you must purchase Club Ac-
counting Software Maintenance and renew it annually.

December 2006

To our Treasurers,

Each year, your club’s members look to you to make sure their
taxes are filed in time. And each year, from December to March,
ICLUBcentral's call volumes triple. We bring in extra help, update
the FAQs, and give it our all to answer your questions. Your pa-
tience during this time is appreciated.

Here’s looking forward to a successful tax season!

Daniel R. Abraham
Director of Technical Support
ICLUBcentral Inc.
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Requesting Technical Support

Use the guide on our web site support request form to help our experts quickly an-
Swer your questions.

Write down the precise wording of any error message displayed when you have a
problem, including the names of any files mentioned in the message.
Be familiar with:
- Theversion of Windows you are using.
The make, model and amount of memory (RAM) on your computer.
The make and modd printer if you have a question regarding the printing
of reports.
Note your Club State Tax Printer serial number and purchase/install ation
date.
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User License and Support Agreement (ULSA)

Applicable to the 2006 Club State Tax Printer. Use of this product is governed by terms
of aUser License and support Agreement or ULSA.

THIS LICENSE AND SUPPORT AGREEMENT (THE "AGREEMENT") IS A LEGAL CONTRACT
BETWEEN YOUR INVESTMENT CLUB OR YOU IN YOUR INDIVIDUAL CAPACITY, AS THE
CASE MAY BE AS INDICATED IN THE PRECEDING PARAGRAPH (COLLECTIVELY, "YOU")
AND ICLUBCENTRAL INC. ("ICLUBCENTRAL"). BY CLICKING ON “ACCEPT” WHEN YOU
INSTALL THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CON-
DITIONS OF THIS AGREEMENT, INCLUDING WITHOUT LIMITATION THE CUSTOMER SUP-
PORT PROVISIONS SET OUT BELOW. IF YOU DO NOT AGREE TO SUCH TERMS AND CON-
DITIONS, YOU MUST PROMPTLY RETURN THE SOFTWARE ICLUBCENTRAL OR ITS SOFT-
WARE DISTRIBUTOR, IN ORDER TO RECEIVE A FULL REFUND OF THE LICENSE AND
CUSTOMER SUPPORT FEES THAT YOU HAVE PAID. If Y ou should have any difficulty in obtain-
ing such refund, please contact ICLUBcentral at 1430 Massachusetts Ave, 3 Floor, Cambridge, MA
02138.

THE ENCLOSED COPY OF THE 2006 Club State Tax Printer, INCLUSIVE OF ALL ADD-ONS AND
FUTURE RELEASES, (the "SOFTWARE"), AND THE RELATED DOCUMENTATION, INCLU-
SIVE OF ALL FUTURE RELEASES (the "DOCUMENTATION"), ARE EACH LICENSED TO YOU
WITH A NON-EXCLUSIVE AND NON-TRANSFERABLE RIGHT, EXCEPT AS ALLOWED BE-
LOW UNDER 'PERMITTED USES, TO USE ONLY UNDER THE FOLLOWING TERMS AND
CONDITIONS:

PERMITTED USES

You MAY: Ingall the Software on a storage device in Y our computer, as set forth in the instructions
contained in the Documentation. Note: The Software has been designed to only allow it to be used for a
singleindividual in Your investment club on a single personal computer.

NON-PERMITTED USES

You MAY NOT:
. Make any copies of the Software.

Make any copies of the Documentation.
Disclose, rent, license, sublicense, lease, sell, lend, disseminate or otherwise digtribute the
Software or the Documentation.
Network the Software or otherwise use it on more than one computer or computer terminal at
the sametime.
Use the Software to conduct a service bureau, application service provider ("ASP") business
or similar business for the benefit of third parties.
Transfer Y our rightsunder this Agreement.
Alter, enhance, supplement, create derivative work therefrom, translate, decompile, disassem-
ble, reverse engineer or otherwise reduce the Software to human readable form.
Remove or obscure the copyright and trademark notice on the label of the storage medium
contai ning the Software or in the Documentation.

TERMINATION/DURATION

This Agreement and Y our license to use the Software and the Documentation will automatically termi-
nate without notice from ICLUBcentral and without any pro rata abatement of the license and customer
support fees You have paid if You fail to comply with any term or condition of this Agreement or upon
your giving written notice of termination to ICLUBcentral.

This Agreement is effective from the day upon which You indicate acceptance of this Agreement. In
order to be granted license to use this Software, you must register this Software fully and accurately with
ICLUBcentral and receive a valid confirmation of regigtration from ICLUBcentral. The license then
granted will continue until either Y ou terminate this Agreement by giving written notice of termination to
ICLUBcentral; or this Agreement isterminated by ICLUBcentral, as provided in theimmediately preced-

ing paragraph.
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CUSTOMER SUPPORT PROVISIONS

Included in the total fee that Y ou have paid for the Software and the Documentation is an amount that
covers limited customer support services as described in this Agreement (the "Customer Support Ser-
vices"). ICLUBcentral will provide limited Customer Support Services for the length of time described
below in the section headed * Support Termination/Duration’ during the term of this Agreement.

Customer Support Obligations of ICLUBcentral:

Provide customer support for the Software only if (i) Y ou have performed the online Product Registra-
tion as provided by ICLUBcentral in order to register the Software; and (ii) Y our copy of the Softwareis
identified with avalid serial number, and Registration Code.

Invegtigate and identify any problem reported by You to ICLUBcentral that is related to the then current
release of the Software, and correct or provide within an appropriate time, as determined by ICLUBcen-
tral, either (i) a workaround for any programming error in the then current release of the Software which
Y ou haveidentified, provided that the error is directly attributable to ICLUBcentral, or (ii) aresolution to
the problem which Y ou have identified (collectively the“ Code Correction Services').

Related Obllgatl ons of End-User:
Use only the then current rel ease of the Software during the term of this Agreement.
In the event of (i) a problem with the Software that results in either a system crash or loop; or
(i) a stuation where You can reasonably demonstrate that the Software produces an errone-
ous arithmetic result that is not a function of incorrect or improper input data, then Y ou must
submit to ICLUBcentral a written report of al input and keystrokes to the Software giving
rise to the problem.

Support Terminati on/Duration:

Answers to questions about ingtallation of the Club State Tax Printer are included with your purchase of
the software. Questions about club accounting principles, tax issues, and the Club Accounting software
are covered by your Club Accounting Maintenance Agreement. To receive full Customer Support cover-
age, you must purchase a Club Accounting Maintenance Agreement and renew it annually.

LIMITED WARRANTY

ICLUBcentral does not have control over the conditions under which Y ou use the Software and does not
and cannot warrant the performance or results that may be obtained by its use. However, ICLUBcentral
warrants that the Software will perform substantially in accordance with the Documentation for a period
of ninety (90) days from the date the product was shipped to Y ou, provided that the Software is used on
the computer equipment, operating system and in the environment for which it was designed and config-
ured. Y our sole remedy and ICLUBcentral ‘s exclusiveliability under the foregoing limited warranty will
be the furnishing by 1CLUBcentral, within a reasonable period of time and without charge, of the Cus-
tomer Support Services pursuant to the Customer Support Services provisions of this Agreement. To
bring a claim under this limited warranty, You should contact Support Department at |CLUBcentral,
1430 Massachusetts Ave, 3rd Floor, Cambridge, MA 02138 to obtain information on warranty perform-
ance; Y ou must be given a Return Authorization Number by ICLUBcentral before returning the Software
to ICLUBcentral. Some jurisdictions do not allow the exclusion or limitation of relief, incidental or con-
sequential damages, so the above limitation or exclusion may not apply to Y ou.

Because computer programs are inherently complex, You are advised to always verify Your work and
periodically (after each use) back up the data Y ou have created with the Software.

ICLUBcentral does not warrant that any of the Software, the Documentation or Customer Support Ser-
vices to be provided pursuant to this Agreement will meet Y our requirements. The only warranty made
with respect to the Softwareis thelimited warranty set forth in this Agreement.

EXCEPT AS SO SPECIFICALLY PROVIDED ABOVE IN THE IMMEDIATELY PRECEDING
PARAGRAPH, THERE ARE NO WARRANTIES, REPRESENTATIONS, OR CONDITIONS MADE
BY ICLUBCENTRAL OR ANY OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION
OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUP-
PORT SERVICES, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, THE
DOCUMENTATION, ANY RELEASES THERETO, OR THE CUSTOMER SUPPORT SERVICES
INCLUDING THEIR RESPECTIVE QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. Notwithstanding the above, where
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applicable, if You qualify as a “consumer” under the Magnuson-Moss Warranty Act, then You may be
entitled to any implied warranties allowed by law for the period of the express warranty as set forth
above. Some gtates do not allow limitations on how long an implied warranty lasts, so the above limita-
tion may not apply to You. This warranty gives Y ou specific legal rights, and Y ou may also have other
rights which vary from stateto state.

LIMITATIONSOF LIABILITY; INDEMNIFICATION

NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRO-
DUCTION, DISTRIBUTION OR SUPPORT OF THE SOFTWARE, THE DOCUMENTATION OR
THE CUSTOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY THIRD PARTY
ARISING OUT OF THIS AGREEMENT AND/OR YOUR USE OF OR INABILITY TO USE THE
SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, REGARD-
LESS OF THE FORM OF THE CLAIM OR ACTION, THAT EXCEEDS THE PORTION OF THE
FEE YOU HAVE PAID FOR THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER
SUPPORT SERVICES, AS THE CASE MAY BE.

NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRO-
DUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUS-
TOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY
SPECIAL, INCIDENTAL, CONSEQUENTIAL, EXEMPLARY DAMAGES OR OTHER INDIRECT
DAMAGES OR LOSS OF PROFITS, LOSS OF DATA OR LOSS OF USE DAMAGES ARISING
OUT OF THISAGREEMENT; AND/OR

THE MANUFACTURE, SALE, SUPPLYING OR FAILURE OR DELAY IN SUPPLYING OF THE
SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES RELATED
THERETO, EVEN IF ICLUBCENTRAL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

Some jurisdictions do not allow the exclusion or limitation of special, incidental, consequential, indirect
or exemplary damages, or the limitation of liability to specified amounts, so the above limitations or
exclusons may not apply to Y ou.

YOU AGREE TO INDEMNIFY AND HOLD ICLUBCENTRAL AND ALL OF THE PERSONS IN-
VOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE
DOCUMENTATION AND THE CUSTOMER SUPPORT SERVICES HARMLESS FROM CLAIMS
AND DAMAGES OF ANY TYPE WHATSOEVER ARISING FROM ANY THIRD PARTY AS A
RESULT OF YOUR USE OF THE OUTPUT FROM, AND/OR YOUR INABILITY TO USE THE
SOFTWARE OR AS A RESULT OF ANY CUSTOMER SUPPORT SERVICES PROVIDED OR TO
BE PROVIDED UNDER THIS AGREEMENT.

GEOGRAPHIC LIMITATION

ICLUBcentral Customer Support Services cannot be provided at the same level to customers outside of
the continental United States, Hawaii and Alaska. ICLUBcentral’s website is available to customers
anywhere in the world. Email support will be provided, on a best efforts bass, to foreign customers, but
only in English. It isunderstood that the ICLUBcentral products have been devel oped for the U.S. mar-
ketplace.

U.S. GOVERNMENT RESTRICTED RIGHTS

The Software and Documentation are “commercial computer software” or “commercial computer soft-
ware documentation.” Absent a written agreement to the contrary, the U.S. Government’s rights with
respect to such Software or Documentation are limited by the terms of this Agreement, pursuant to FAR *
12.212(a) and/or DFARS* 227.7202-1(a), asapplicable.

GENERAL PROVISIONS

The Software, the Documentation, and all rel eases thereto are licensed to Y ou by ICLUBcentral, and are
protected by United States copyright laws and by international treaty provisons. Title to the Software
and the Documentation, and patents, copyrights and all other property rights applicable thereto, shall at
al timesremain solely and exclusively with ICLUBcentral and itslicensors, and You shall not take any
action incongstent with such title. Therefore, except for the permitted right to make one (1) back up copy
of the Software, Y ou must treat the Software and the Documentation like any other copyrightable mate-
rial and are precluded by law from making any copies of them. Any rights not expressly granted herein
arereserved to ICLUBcentral and its licensors.
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The rights and obligations under this Agreement will be governed by, and any arbitration or court action
hereunder shall apply, the laws of the Commonwealth of Massachusetts, excluding its conflicts of law
rules, and will not be governed by the United Nations Convention of Contracts for the International Sale
of Goods, the 1974 Convention on the Limitation Period in the International Sale of Goods (the “1974
Convention”) and the Protocol amending the 1974 Convention, done at Vienna April 11, 1980, the appli-
cation of which isexpresdy excluded.

Any dispute, controversy or claim arising out of or relating to this Agreement or to a breach hereof, in-
cluding itsinterpretation, performance or termination, shall be resolved in the courts of Massachusetts.

The parties irrevocably submit to the exclusive jurisdiction of the federal and state courts of Massachu-
setts. Notwithstanding anything contained in this paragraph to the contrary, ICLUBcentral shall have the
right to institute judicial proceedings againg You or anyone acting by, through or under You, in order to
enforce ICLUBcentral’ s rights hereunder through reformation of contract, specific performance, injunc-
tion or similar equitable relief.

If any term or condition in this Agreement isinvalid or unenforceable in any respect under any applicable
statute or rule of law, then such term or condition is modified to have the most nearly similar permissible
economic or other effect in order to be valid and enforceable under such applicable statute or rule of law.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT
THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE RELATION-
SHIP BETWEEN YOU AND ICLUBCENTRAL, AND SUPERSEDES ALL PRIOR OR CONTEM-
PORANEOUS PROPOSALS, ORAL OR WRITTEN, UNDERSTANDINGS, REPRESENTATIONS,
CONDITIONS, WARRANTIES, AND ALL OTHER COMMUNICATIONS BETWEEN YOU AND
ICLUBCENTRAL OR BETWEEN YOU ANY OTHER PERSON INVOLVED IN THE CREATION,
PRODUCTION OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE
CUSTOMER SUPPORT SERVICES; AND THIS AGREEMENT MAY NOT BE EXPLAINED OR
SUPPLEMENTED BY CUSTOM OR USAGE OF TRADE OR ANY PRIOR COURSE OF DEAL-
INGSBETWEEN YOU AND ANY OTHER PERSON.

IF THERE ARE ANY CONCERNS REGARDING THIS AGREEMENT, PLEASE CONTACT:
ICLUBCENTRAL, 1430 MASSACHUSETTS AVE, 3rd FLOOR, CAMBRIDGE, MA 02138.
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